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Protocol 2. SMTP 3. Router 4. Mesh 5. NIC

Protocol is a set of rules that governs the communication between the computers over a
network.

. The components needed for a network are:
(i) Network Interface Card (NIC)
(i) Hub or switch
(iii) Router
(iv) Modem
(v) Networking Cable (Ethernet Cable)
. A client is a computer which depends on the server for all the resources.
A server controls the access to the hardware and software on the network.
Topology refers to the geometric arrangement of computers or nodes in a network.

Computer network means a system of interconnected computers. The advantages of computer
network are:

(i) The information can be easily shared by the people.
(ii) It helps in reducing the cost of hardware.
(iii) Store information on one centralised location.

(iv) Reliability implies backing up of information. If a system crashes, then the information is
accessible on another workstation for future use.

(v) Reduction in installation cost.
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2.

LAN is a digital communication system that interconnects a larger number of computers and
other peripheral devices within a radius of less than 1 km. MAN consists of two or more local
area networks or campus area networks together that usually spans several buildings in the
same city or town.
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2. Windows— Photos and Video Editor
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. Photos 2. Rotating 3. Spot fix 4. New video project

. Red eye feature

. Video editing means to add some new content in an existing video or apply some effects

the video.

. Yes, we can add 3D effects in a video using 3D effects button.

. Rotating means to change the position of a photo at different angles. Flipping means to get

the mirror image of the photo either horizontally or vertically.

. Steps to trim a video in Photos app:

Step 1 Open a video and add it to the storyboard.
Step 2 Click on the Trim button.

Step 3 Two handles appear at both ends of a video time line which allow you to trim a video
from starting as well as from end.

Step 4 Click on the Done button. The video will be trimmed.

Rahul can use trim option to remove some portion of the video.
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Worksheet 1

(Based on chapters 1 & 2)

. Local Area Network 2. Personal Area network
. Star Topology 4. Mesh Topology

. video, storyboard

. 3D effects

. 3D effect, video

. Done

. Rotating 2. Flipping 3. Protocol 4. Wi-Fi

Introduction to GIMP

EXERCISE @’
b 2.c 3.a 4. a
. Workspace 2. GIMP 3. Layer effect 4. Layers palette
. Patterns 6. Fill with

. GIMP has user friendly interface.
. Template represents image types that are commonly useful.
. Menu bar, Toolbox and Layers palette.

. To save a file, follow the given steps:

Step 1 Click on File menu.

Step 2 Click on Save option.

Step 3 Navigate the folder to save the file.

Step 4 Given the name of the file in the Name: box.

Step 5 Click on Save button.

. To open an image, follow the given steps:

Step 1 Click on the File menu.

Step 2 Click on the Open option.

Step 3 Choose the image to be inserted.
Step 4 Click on the Open button.
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3.

The Create a New Image dialog box provides the following options:

Template: It represents image types that are commonly useful. The template sets values for
the size, resolution, comments, etc.

Image Size: It specifies the width and height of the new document in pixels, centimeters,
inches, points, millimetres, etc.
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4. Using Tools in GIMP
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. Rectangle Select 2. Text 3. Sharpen 4. Clone

. Fuzzy Select tool is used to detect the edges of the image automatically on the basis of colour

codes and do the selection quickly.

. Retouching tools help you to add or remove objects from an image.

. Smudge tool is used to show the image as the wet paint on the image has been spread by

a finger.

. Paintbrush tool is used to draw brush strokes to give an effect of painting to the image. The

Paintbrush tool shows various options. For example, Opacity option is used to increase or
decrease the transparency of the brush color. To use Opacity option:

Step 1 Choose a colour for your Paintbrush by adjusting the gradient sliders.
Step 2 Choose the type of Brush from the Brushes tab.
Step 3 Click on the workspace and drag to draw the flow of brush.

. To use Clone Tool, follow the given steps:

Step 1 Open the image and then click on Clone Tool.
Step 2 Select the brush size and hardness from Tool Options.
Step 3 Press and hold the Ctrl key and click on the image to be cloned.

Step 4 Click and drag the mouse at the place where the clone is to be created.

. To use Blur tool, follow the given steps:

Step 1 Open an image.

Step 2 Click Blur/Sharpen Tool.
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F.

Step 3 Select the brush size and hardness.
Step 4 Click and drag the mouse pointer over the area that you want to blur.
She should use Fuzzy Select tool and Crop tool.
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5. Advanced Features of GIMP

l
A.
B
C
D

EXERCISE @,
la 2.b 3.b 4.c
1.F 2.F 3.F 4.7
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1. Layers are transparent sheets which are stacked on top of each other so that individual objects
of an image can be edited without affecting other objects.

2. Filters are tools which are used to modify an image in a variety of ways.
3. Hiding a layer means to make the layer temporarily invisible.

1. Flattening layers means combining all the layers of an image to make one layer. To flatten
layers, follow the given steps:

Step 1 Select a layer which you want to flatten.
Step 2 Right click on the Layers palette and select Flatten Image.
2. To delete a layer, follow the given steps:
Step 1 Select a layer from the Layers palette.
Step 2 Click on the Delete layer button.
3. To apply filter to an image, follow the given steps:
Step 1 Open an image in GIMP.
Step 2 Select the part of the image where you want to apply the filter.
Step 3 Click on the Filters menu from the menu bar.
Step 4 Choose Blur filter from this submenu.
Step 5 Click on Gaussian Blur option.
Step 6 Increase the value of the X and Y size to decrease or increase the effect of the filter.

Step 7 After you have applied the suitable value to the filter, click on OK button to apply the
effect.
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F. 1. Selection Tool 2. Merge two images
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Worksheet 2
(Based on chapters 3 to 5)
A.
Layer tab g = Layers [l Channels % Paths =
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Lock Pixels
Eye icon Layer stack

Raise this layer

Creater a
duplicate layer

Creater a new
layer group

Creater a new layer - Delete a layer

Anchor a floating layer
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C. 1. Healing Tool 2.Clone Tool
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Test Sheet 1

(Based on chapters 1 to 5)

Section A
A. 1. (i) 2. (iii) 3.(3i) 4. (ii) 5. (i)
6. (ii) 7. (i) 8. (ii)
B. 1T 2.7 3.7 4.F 5T
6.T 7.F
C. 1. Protocol 2. Mesh 3. NIC 4. Rotating
5. New video project 6. GIMP 7. Layer effect 8. Fill with
9. Sharpen 10. Clone
Section B
A. 1. The components needed for a network are:

v A W N

(i) Network Interface Card (NIC)

(ii) Hub or switch

(iii) Router

(iv) Modem

(v) Networking Cable (Ethernet Cable)

. Red eye feature
. Template represents image types that are commonly useful.
. Menu bar, Toolbox and Layers palette.

. Fuzzy Select tool is used to detect the edges of the image automatically on the basis of colour

codes and do the selection quickly.

. Hiding a layer means to make the layer temporarily invisible.

. LAN is a digital communication system that interconnects a larger number of computers and

other peripheral devices within a radius of less than 1 km. MAN consists of two or more local
area networks or campus area networks together that usually spans several buildings in the
same city or town.

. Rotating means to change the position of a photo at different angles. Flipping means to get

the mirror image of the photo either horizontally or vertically.

. The Create a New Image dialog box provides the following options:

Template: It represents image types that are commonly useful. The template sets values for
the size, resolution, comments, etc.
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Image Size: It specifies the width and height of the new document in pixels, centimeters,
inches, points, millimetres, etc.

4. To open an image, follow the given steps:

Step 1 Click on the File menu.

Step 2 Click on the Open option.

Step 3 Choose the image to be inserted.

Step 4 Click on the Open button.
5. To use Clone Tool, follow the given steps:

Step 1 Open the image and then click on Clone Tool.

Step 2 Select the brush size and hardness from Tool Options.

Step 3 Press and hold the Ctrl key and click on the image to be cloned.

Step 4 Click and drag the mouse at the place where the clone is to be created.
6. To apply filter to an image, follow the given steps:

Step 1 Open an image in GIMP.

Step 2 Select the part of the image where you want to apply the filter.

Step 3 Click on the Filters menu from the menu bar.

Step 4 Choose Blur filter from this submenu.

Step 5 Click on Gaussian Blur option.

Step 6 Increase the value of the X and Y size to decrease or increase the effect of the filter.

Step 7 After you have applied the suitable value to the filter, click on OK button to apply the
effect.

6. Introduction to TUPI 2D

l EXERCISE @;’

A. la 2.a 3.b 4. a 5.¢
B. 1.F 2.T 3.T 4.7 5T
C. 1. Player 2. Library 3. Toolbox 4. Exposure sheet

D. 1. Animation is a way through which you can show characters and objects live.

2. Brushes tool is used to draw a closed rectangle, ellipse or a line.

3. Menu Bar, Modules Tab and Workspace

N

N
=8 L Touchpad MODULAR (Version 2.0)-VIII (Answer Key)

S—

LA



E. 1. To start TUPI 2D, follow these steps:
Step 1 Type TupiTube in the search box.
Step 2 Click on TupiTube Desk.

2. Object Selection tool helps the user to modify, flip or group objects as per their requirements
whereas Node Selection tool helps to reorder the nodes which were created while drawing
an object.

3. Steps to add an object to the Library panel:
Step 1 Click on the Library button.

Step 2 Click on + symbol to add an object in into the library. Import image dailog box will
appear.

Step 3 Select the file and click Open button.
4. Type of files that can be added to the library are:
(i) Image File
(ii) Svg File
(iii) Native Object
(iv) Image Sequence
(v) Sound File

IN THE LAB

7. Animations in TUPI 2D

l EXERCISE @,

A. 1lc 2.a 3.b 4.c

B. 1F 2.F 3.F 4.7

C. 1. Tween helps us to make animation process easier and faster.

2. Layers are like stack of transparent sheets that are used to work on the individual part of the
image without affecting the other parts.

3. Coloring Tween changes the color from the beginning frame to the ending frame.
D. 1. We caninsert the frames in TUPI by following the given steps:
Step 1 Click on the Exposure Sheet.

Step 2 Click on Insert Frame button.
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Step 3 A new frame will be inserted.
2. Steps to create opacity tween are:
Step 1 Draw a rectangle using a Brush tool.
Step 2 Click on Tween option and choose Opacity Tween.
Step 3 Enter a name for the animation and click on the + button.
Step 4 Click on the object and then click on Set Path Properties.

Step 5 Now set the properties as starting frame and ending frame. Set initial and ending
opacity level and set iterations, loop.

Step 6 Click on the Save button to save the animation.

3. Rotation Tween is useful to rotate an object clockwise and anti-clock wise because the Rotation
tween automatically rotates the object as per the specification given.

E. Shweta can rename a layer by double-clicking on it.
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Worksheet 3
(Based on chapters 6 & 7)
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B. 1. Rotation Tween

2. Library
3. Clockwise
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. Welcome screen
. Expanded Panel

. Color Palette

App Development

[ EXERCISE ()

A. la 2.a 3.a 4.b

B. 1F 2.T 3.F 4.T 5T

C. 1. hybrid 2. Mobile 3. Android 4. gaming 5. Install

D. 1. Anappisa software program primarily developed for hand-held smart devices such as mobile
and tablet.

2. Web apps are actually web applications which give a user experience similar to native apps.

3. Built-in Blocks, Component Blocks and Workspace

E. 1. (i) Gaming Apps- Today's most popular category of mobile apps is gaming apps which share
more than 24% area of the app store. The most commonly used gaming apps are PUBG,
Candy Crush Saga, and Angry Birds.

(i) Productivity apps, also known as business apps used by businessmen to perform several
complex tasks. The most commonly used productive apps are Google Calendar, Evernote
and Dropbox.

(iii) Entertainment apps are developed to entertain the people. The most commonly used

entertainment apps are Netflix, Talking Tom and YouTube.

2. To change the display name, follow the given steps:

Step 1 Click on the button in the View pane.

Step 2 Type a new name for button in the Text box.

3. The difference between web app and website is that a web app can be a small part of a
website which provides a particular functionality. On the other hand, a website can contain
many web apps.

4. Educational apps provide a platform for children to learn from anywhere and anytime. These
apps use advance methodologies and new concepts to make the learning easier. The most
commonly used educational apps are Khan Academy and Vedantu.

F. 1.Gaming 2. Music Player
L INTHELAB e
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9. Loops in Python
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la 2.a 3.a 4.c
.one 2. non-zero, false 3. Infinite 4. break, continue
.F 2.F 3.7 4.7 5T

. Looping refers to the process of repeating a set of statements repeatedly on the basis of a

condition until the condition is falsified.

. The syntax of for loop is

for <variable> in <iterator>:

Statements

. Jumping statements are used in Python when the control of the program needs to be

transferred out of the loop body, even if all the values of the iterations of the loop have not
been completed.

for each item
in sequence

Last item . True
reached?

lFaIse

—— Body of for

l

\/
Exit loop

. The while statement executes a set of statements repeatedly, until the logical expression

evaluates to true. When the condition becomes false, the control comes out of the loop.
The syntax of while statement is given below.

Syntax:

while (test expression):

Statements
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. False
—>_Test Expression
lTrue
Execute while Block
\J
Exit loop

3. The break is a keyword in Python which is used for bringing the program control out of
the loop. When a continue statement is encountered inside a loop, control of the program
jumps to the beginning of the loop for next iteration, skipping the execution of rest of the
statements of the loop.

F. 1.55
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Worksheet 4
(Based on chapters 8 &9)

A. 1. Google Play Store 2.i0S 3. Hybrid app 4. Gaming app

5. Educational app 6. Social networking apps
B. 1L.i=0

while i < 5:
print (i)
i+=1
if 1 ==
break
else:
print (0)
2.1 =0
while i < 3:
print (i)
P,
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else:
print (0)
C. 1 =20
while (1 > 0)
if (1 %2 !'=20):

print (i)

i -=1
D. num = float (input (“Enter the distance measured in centimeter : “))
inc = num/2.54

m = inc/36;

print (“Distance in inch : , inc)

print (“Distance in meter : %, m)

Test Sheet 2

(Based on chapters 5 to 8)

Section A

A. la 2.a 3.b 4.c 5.a
6. a 7.¢c 8.a

B. 1F 2.7 3.F 4.7 5.F
6.T 7.F 8T

C. 1 Library 2. Toolbox 3. hybrid 4. gaming 5. one

6. non-zero, false

Section B

A. 1. Brushes tool is used to draw a closed rectangle, ellipse or a line.
2. Menu Bar, Modules Tab and Workspace
3. Tween helps us to make animation process easier and faster.
4. Web apps are actually web applications which give a user experience similar to native apps.

5. Looping refers to the process of repeating a set of statements repeatedly on the basis of a
condition until the condition is falsified.

6. Jumping statements are used in Python when the control of the program needs to be
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transferred out of the loop body, even if all the values of the iterations of the loop have not
been completed.

. To start TUPI 2D, follow these steps:
Step 1 Type TupiTube in the search box.
Step 2 Click on TupiTube Desk.

. Rotation Tween is useful to rotate an object clockwise and anti-clock wise because the Rotation
tween automatically rotates the object as per the specification given.

. The difference between web app and website is that a web app can be a small part of a
website which provides a particular functionality. On the other hand, a website can contain
many web apps.

. The while statement executes a set of statements repeatedly, until the logical expression
evaluates to true. When the condition becomes false, the control comes out of the loop.

The syntax of while statement is given below.
Syntax:

while (test expression):

)

Statements

. False
—>_ Test Expression
lTrue
Execute while Block
\J
Exit loop

Li=1
while i<=100:
print (i)

i4=1

) W
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